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1: Using the SSI Module

Introduction

The SNAP-SCM-SSI module provides two individually isolated serial synchronous interface (SSI)
inputs for acquiring data from linear or rotary transducers used in motion control.

The module can decode both binary and Gray Code, and is software configurable to set clock speed,
frame length, delay time between data samples, and other parameters.

SNAP SSI modules mount alongside analog, digital, and other serial modules on any SNAP PAC rack
with a SNAP PAC brain (either EB or SB) or an R-series controller. The brain or controller processes the
data from the module and can communicate the data to other parts of an Opto 22 SNAP PAC
System™ or to another system (such as an OPC client or a Modbus® system).

SNAP PAC racks accommodate up to 4, 8, 12, or 16 1/0 modules, with a maximum of 8 serial
modules (including SSI modules) on any one rack. Because the SNAP-SCM-SSI module is mounted
on these standard racks with other SNAP /O modules, you can use the combination of analog,
digital, and serial modules required by your application at the location where they are needed.

NOTE: SSImodules require a SNAP PAC brain (either EB or SB) or an R-series controller with firmware version
8.5¢c or newer. These modules do not work with legacy brains or controllers.

This guide assumes that you have some familiarity with Ethernet networking and the serial
synchronous interface. Commercial resources are available for learning about these subjects. To
learn about SNAP PAC brains and controllers or other SNAP 1/O modules, visit the Opto 22 website at
WWW.0pto22.com.

This guide includes the following chapters:
Chapter 1: Using the SSI Module describes the module and how to
install, configure, and read data from it.
? Chapter 2: Specifications and Additional Information includes
specs, dimensional diagrams, and handy tables to use when
configuring the module.
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INSTALLING THE SSI MODULE

For Help

If you have problems installing or using the SNAP-SCM-SSIand cannot find the help you need in this
guide or on our website, contact Opto 22 Product Support.

Phone: 800-TEK-OPTO (800-835-6786 NOTE: Email messages and phone
toll-free in the U.S. and Canada) calls to Opto 22 Product Support
951-695-3080 are grouped together and
Monday through Friday, answered in the order received.

7 a.m.to 5 p.m. Pacific Time

Fax: 951-695-3017
Email: support@opto22.com
Opto 22 website: Www.opto22.com

When calling for technical support, be prepared to provide the following information about your
system to the Product Support engineer:

Detailed data sheet for the transducer you are using

Software and version being used

PC configuration (type of processor, speed, memory, and operating system)
A complete description of your hardware and operating systems, including:
- loader and firmware versions for the controller or brain, and device type
— IP addresses and net masks for devices on the system

- type of power supply

- third-party devices installed (for example, barcode readers)

Specific error messages seen

Installing the SSI Module

Requirements

You'll need the following to install the SNAP-SCM-SSI module:

/0 unit consisting of a SNAP PAC rack, a SNAP PAC EB or SB brain or R-series controller with
firmware R8.5¢ or newer, and (optionally) other I/O modules

Manufacturer's data sheet for the transducer

PAC Manager 9.0 or newer, installed on a PC on the same network segment as the I/O unit

SNAP SSI (Serial Synchronous Interface) Module User's Guide


mailto:support@opto22.com
http://www.opto22.com

CHAPTER 1: USING THE SSI MODULE

Installing the Module on the Rack
SNAP SSI'modules can be installed in any position on an Opto 22 SNAP PAC mounting rack.

NOTE: SNAP SSI modules draw more power than a standard SNAP analog or digital module. As a rule, the
rack can handle a maximum of eight serial modules (including SSI modules), plus the processor and up to
eight digital or analog modules. Power can usually be supplied by an Opto 22 SNAP-PS5 power supply;
however, check total power requirements for the processor and all modules on the rack to make sure you
have sufficient power.

1. Turn off power to the rack.

WARNING: Make sure power is off before continuing, or you will severely damage the module.

2. Position the module over the
connector on the rack, aligning the
slot in the module’s base with the
retention bar on the rack. If it is next
to another module, make sure the
male and female module keys are
aligned, as shown at right.

3. Push straight down on the module
to snap it into position.
4, Usetwo standard 4-40 x 1/4

truss-head Phillips holddown screws
to secure both sides of each module.

CAUTION: Do not over-tighten screws.
See “Specifications”on page 11.

To remove a module, see page 14.

Wiring the SSI Module to Field Devices

Top of Module Wire each port on the module Use twisted-pair, 24-gauge
to a transducer as shown. shielded cable with an
. additional pair for common
Pin Use (three pairs total).
1 Clock +
Pin 1, Port 0 —» 2 Clock —
3 Data -
4 Data +
5 Excitation common

Pin1,Port 1 —»

o000 LSOOD
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CONFIGURING THE SSI MODULE

Configuring the SSI Module

To configure the SNAP-SCM-SSI, you'll need the following information on the transducer you're
using with it. A detailed data sheet should contain most of this information, but you may need to
contact the manufacturer for some of it:

«  Data frame size

«  Data frequency in kHz

« Idle time between frames (in microseconds)
«  Data bit location in data frame

«  Number of data bits

«  Status bit location in data frame

«  Status bit indication level

«  Dataencoding (binary or Gray)

Calculating Configuration Parameters for PAC Manager

Use the transducer manufacturer’s data sheet to calculate or obtain the following parameters, which
PAC Manager requires for configuring the SNAP-SCM-SSI module. You can complete the tables on
page 13 to make configuration easier (especially useful if you have more than one transducer type).

Data Frame Length—The total number of bits the SNAP-SCM-SSI should receive from the
transducer. This number is larger than the number of data bits the transducer supports, because
SSl-oriented transducers transmit the digital data within a frame that includes additional
information, such as error indication bits.

Clock Divider—Each transducer’s serial data is delivered at a specific clock frequency. Typically this
value is specified in kHz, and it may be indicated as a range. The SSI module uses an internal

20,000 kHz (20 MHz) clock. Because this clock rate is too fast for most transducers, you set the
divider parameter to slow down the data transfer rate between the transducer and the SSI module
so that it falls within the transducer's specified range. Calculate the divider appropriate for your
transfer speed as follows:

Clock Divider = 20,000 kHz / (Transducer Data Frequency)

If the result contains a fraction, round up to the next whole number. For example, if the result is 19.3,
use 20 as the Clock Divider. If the result is 26.0, use 26.

IMPORTANT: The Clock Divider must not be less than 8. If it is less, select a slower frequency available on
the transducer. The maximum data frequency input of the SSI module is 2,500 kHz.

Data Delay (in Clock Cycles)—The number of clock cycles the transducer requires between the
last clock of one data frame and the first clock of the next. Manufacturers may describe this
parameter in units of time (us). If so, calculate the data delay as follows:

Data Delay = Idle Time between frames in us/(0.05 us * Clock divider)
Or presented another way:

Idle Time between data frames in ps = Data Delay * (0.05 ps * Clock divider)
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CHAPTER 1: USING THE SSI MODULE

For example, if the Clock Divider = 32 and the Data Delay = 64, then:

64 * (0.05 us * 32)
102.4 microseconds

Idle Time between data frames in us
Idle Time between data frames in us

If the result of the data delay calculation is fractional, round up to the next whole number. In this
example, if the result is 63.2, use 64 as the Data Delay. If the result is 63.0, use 63.

Most Significant Data Bit Offset—Transducer manufacturers place the first data bit (MSB) in the
data frame in various positions. This parameter tells the SNAP-SCM-SSI where to look for the first
data bit. The offset should be available from the manufacturer. Note that the SNAP-SCM-SSI's bits
start at zero, not one. Other manufacturers may start counting with bit 1. If so, adjust bit positions
accordingly.

Data Bits in the Data Frame—This value indicates how many bits of the data frame are used to
report the transducer’s position. The SNAP-SCM-SSI module supports a maximum of 24 data bits.
Sensors with resolution higher than 24 bits can be used, but only 24 bits of data, starting with the
MSB, will be read. For example, if an encoder with 27 bits of data is connected to the module, the 24
most significant bits (MSB) will be read, and the 3 least significant bits (LSB) will be ignored
(truncated).

Error Bit Offset and Level—Most SSl-interfaced positional transducers have a status or error status
indication. This error indicates when the transducer reading is questionable, thus generating an
error state. Manufacturers also choose the status bit state (high or low) to indicate a questionable
reading. The SNAP-SCM-SSI module needs to know where this bit is located within the data frame
and which level of this bit (high or low) indicates a faulty reading. Only one error bit can be
monitored. If the error bit is in an error state, the module will read -8388608. If your encoder has no
error bit, use a value of -1 for Error Bit Offset in the Data Frame.

Data Encoding—The SNAP-SCM-SSI module accepts either binary or Gray encoded data.

Configuring the I/0 Unit with PAC Manager

You use PAC Manager, a free configuration utility, to configure the SNAP-SCM-SSI on the 1/0 unit.
PAC Manager 9.0 or newer is required.

PAC Manager comes on a CD with every SNAP PAC brain and controller and is also available for
download from the Support section of our website, www.opto22.com. For information about using
PAC Manager, see the PAC Manager User’s Guide, form #1704,

1. Turnon the I/O unit.
2. If PAC Manager isn't open, choose Start > Programs > Opto 22 > PAC Project > PAC Manager.

3. In PACManager, open the configuration file for the I/O unit the module is on, or configure a
new I/0 unit. (You can also configure the module in PAC Manager’s Inspect window.)

4, Right-click the name of the I/O unit and choose Configure from the popup menu.
The Configure I/0 Units dialog box opens (see the next page).
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CONFIGURING THE SSI MODULE

=»| Configure I/O Units

==l

Address

10.192,55.189
10.192.54.110

Port

Ethernet
Ethernet

Watchdog 1
Disabled
Enabled

Add...

Modify...
Delete

Import/Copy...

/O Points...
PID Loops...
Modules :—]—— Modules
M button
L Communications »
Others 3

MName Type
G4 Digital_... G4EB2
Preprocess SNAP-PAC...

4 I

Close |

Help |

5. Make sure the correct I/0 unit is highlighted. Click the Modules button and choose SSI Modules
from the pop-up menu.

] Configure S5 Modules @
551 Module
Mumber: |0 | [ Used
Address | D escription | Walue
PORT O
O«FFFF FOZA 1000 [1ata Frame Length i]
0xFFFF FO3& 1004 Clock Divider ]
(«FFFF FOZA 1003 Data Delay, Clock Cycles i]
(wFFFF FOZA 100C ozt Significant Diata Bit Offget i]
0=FFFF FO3& 1010 Data Bits in the Data Frame 0 »» 24 Max <<
0=FFFF FO3& 1074 Error Bit Qffzet in the Data Frame ]
O«FFFF FOZA 1013 Error Bit Lewel High EBit Indicates Eror = |
(wFFFF FOZA 1010 [1ata Encoding Binary =1
OxFFFF FOZA 1020 Enable Scanning Dizabled =1
PORT 1
OxFFFF FOZA 1040 [1ata Frame Length i]
0=FFFF FO3& 1044 Clock Divider ]
(«FFFF FOZA 1043 Data Delay, Clock Cycles i]
(wFFFF FOZA 1040 ozt Significant Diata Bit Offget i]
0=FFFF FO3& 1080 Data Bits in the Data Frame 0 »» 24 Max <<
0=FFFF FO3& 1054 Error Bit Qffzet in the Data Frame ]
(xFFFF FOZA 1053 Error Bit Lewel High EBit Indicates Eror = |
(wFFFF FOZA 1080 [1ata Encoding Binary =1
O«FFFF FOZA 1080 Enable Scanning Dizabled =1
Cancel |

6. Inthe Number field at top, choose the SSI module’s position from the drop-down list. Click to

put a check mark in the Used box.
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CHAPTER 1: USING THE SSI MODULE

7. ForPort 0, use the values you calculated in the previous section to configure all parameters,
either by entering the value or by choosing it from the dropdown list. Under Enable Scanning,
choose Enabled.

Based upon the values you enter, PAC Manager shows the actual data frequency in kHz and the
data delay in microseconds (us). Since the SSI module accepts a maximum of 24 data bits, if
you enter a value higher than this, it is reduced to 24.

8. Repeat for Port 1.

9. When you have finished entering parameters for both ports, repeat from step 6 for additional
SSImodules.

10. When all SSI modules are configured, click OK.

11. Save the configuration file. When you have completed configuring the I/0 unit, follow steps in

the PAC Manager User’s Guide to load the configuration file to the I/O unit and save to flash
memory.

Configuration Example

In this example our transducer has the following specifications:

Example: SSI data format encoder

Opto22bit:‘0|1‘2|3|4|5|6‘7I8I9‘10|11|12|13|14‘15|16|17‘18|19|20‘=21

Clock +

U

Encoder Mfr’s bit:

1

bits total

LU L L e L L L L U

%

11234 |5|6|7|8|9]|10|1[12]13|14[15[16 |17 |18 19 20 21
17 (16|15 |14 (13|12 (11|10l 9 |8 |7 6|5 |4 |3 |2[1]|0|D| T DO
z . AEIEIEIR:
& < 18 data bits —————» PT35S |bits total
3 error bits
From this data we calculate the following parameters:
Module Position on Rack (0-15): 5
Configuration Parameter Port 0 value Port 1 value

Data Frame Length 21

Clock Divider 32

Data Delay in Clock Cycles 64

Most Significant Data Bit Offset 0]

Data Bits in the Data Frame 18

Error Bit Offset in the Data Frame': 2 19

Error Bit Level H|9h is Error

Data Encoding Gr‘ay

1. Error bit 2. Only one error bit can be monitored. In this example, for error bit 1, error bit off-

set

= 18; for error bit 3, error bit offset = 20.

2. If your encoder has no error bit, use a value of -1.
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READING DATA FROM THE I/0 UNIT

When we've entered the values and enabled scanning, the PAC Manager configuration window
looks like the following:

| Configure S5I Modules @

5SI Module

Mumber: |0 | [ Used

Address | Description | Value |

PORTO
OxFFFF FO3A 1000 Data Frame Length 21
0xFFFF FO3A 1004 Clodk Divider 32 £ B2R0kHz <X
OXFFFFFO3A 1008 Data Delay, Clock Cydes B4 &> 1024 usec —Calculated.data
0xFFFF FO3A 100C Most Significant Data Bit Offset 0 frequency inkHzand
0xFFFF FO3A 1010 Data Bits in the Data Frame 18 d P

ata delay in s

0xFFFF FO3A 1014 Error Bit Offset in the Data Frame 19 yinu
OxFFFF FO3A 1018 Error Bit Level High Bit Indicates Eror
OxFFFF FO3A 101C Data Encoding Gray
OxFFFF FO3A 1020 Enable Scanning Enabled

PORT 1

OxFFFF FO3A 1040 Data Frame Length 21

OxFFFF FO3A 1044 Clock Divider 32 > B28.0kHz <

OxFFFF FO3A 1048 Data Delay, Clodk Cydes B4 1024 uzec

OxFFFF FO3A 104C Most Significant Data Bit Offset 0

0xFFFF FO3A 1050 Data Bits in the Data Frame 18

0xFFFF FO3A 1054 Error Bit Offset in the Data Frame 19

OxFFFF FO3A 1058 Error Bit Level High Bit Indicates Errar = |
OxFFFF FO3A 105C Data Encoding Binary j
Disabled =

W

Reading Data from the /0O Unit

You can read data from the SSI module as counts and as scaled units. Both values are in an IEEE 754
32-bit floating point format. (For details about this format, see the PAC Manager User’s Guide.)

You can see the data in PAC Manager for testing purposes. You can use the data in a PAC Control
strategy or in a custom program you've written using the OptoMMP protocol. A Modbus/TCP client
can also read and use the data.

NOTE: Ifthe error bit is in an error state, the module will read -8388608.
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CHAPTER 1: USING THE SSI MODULE

How the SNAP-SCM-SSI Samples Data

The SSI'module outputs a high clock signal during idle, and it samples SSI data on falling edges of
the clock, starting after the first rising edge. The following diagram shows details.
Example of data sample with out-of-range error bit

I Clock cycle (frame length) Idle (inter-frame delay)

P
l‘ n-1 n g g
+Oock‘|!+!+_ﬂﬂ_4 :1_:|_:+_4—
S N e i}

, Error

First
sample Second sample Last sample

Control Considerations

Both counts and scaled unit data from the SSI module are in an IEEE 754 32-bit floating point format.

The scaled units represent a proportional value of measurement. The value is normalized to a 24-bit
transducer, even though the actual transducer may have different bits of resolution.

In our example, the transducer we're using has 21 bits of data resolution. The maximum reading can
be calculated by this formula:

1
24 — Bits of Data Resolution))

Maximum Reading = I
(2

In our transducer example from page 7, the maximum reading value is:

1
24 — 21))

0.125 = (
(2

When the transducer exceeds the limit of measurement, a value of zero is reported (whether
off-scale high or off-scale low). Due to this limitation, the probe should be installed in such a way
that the measured displacement never reaches an off-scale value. If an off-scale value is reported,
the control or monitoring system should consider it a fault.

Reading Data in PAC Manager

Once the module parameters are configured, the I/0 unit immediately begins reporting data from
the transducer. You can see the data in PAC Manager’s Inspect window.

1. If PAC Manager isn't open, choose Start > Programs > Opto 22 > PAC Project > PAC Manager.

2. (lickthe Inspect button @ or choose Inspect from the Tools menu.

3. Inthe Device Name field, type the IP address or name of the I/0 unit.

4. (lick Analog Point. This is where SSI module values are displayed. Choose the module position
and point (port) O or 1.

Our example was port 1 on module position 5, so we chose module 5 and point 1in the
Inspect window. Here's how the data looks (see next page).
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READING DATA FROM THE I/0 UNIT

w=p| Inspect Opto 22 Device |E| = @l
Device Mame: [10.152.54.74 x| | Optins » | Statuz: |Analog Point area last read at 05/06/10 11:46:58
Status Read Analog Paint
Status Write J Step 1: Choose a module

[Modue [0 1 2 3 4B 6 78 & 10 1112 13 14 15 Typer  SSI(04FA)
Wireless LAN ’] Step 2: Choose a point on the selected module

Point 0 EE
Point Config 7o
Digital Bank | ReadArea
Digital Paint Address [ Crescription
0=FFFF FO26 5040  Scaled Units
Analog Bank 04FFFF FO26 5044 Counts
0+FFFF FO26 5048 Min Value [Scaled Urits] 00z
Analog Point OxFFFF FOZ26 504C  Max, Value [Scaled Urits) 00EE
0=FFFF FO26 50684 Raw Counts 16
High Density
“Wfiite Area-
SEEm Dt i Clear | Offset and Gairc
ScratchPad  # OxFOID 4FOC Step 1: Use a calibratar bo input the signal correspanding

L il [; 1 I} Al
l ee o zero Engneening Unitz
_ Datalog ¥ ' et | F 0D 4F10
- CEATE Step 2 | Calc and Set Offset
PID 3 [ [ B0da

Buto b (0RED:
1109128 00 Apply Step 3; Use a calibrator to input the signal corresponding
Events ’ ,—J to the point's masium nominal value
Communications » 17 s Step4: | Calcand Set Gan
i il ]

Close ‘ Help ‘

Type:  Generic input [k01]
' Feature: Maone (0x00)
MName:

| Eefresh |

Both the counts and scaled units are displayed. Both values appear in an IEEE 754 32-bit
floating point format (for more information, see the PAC Manager User’s Guide).

Reading Data in PAC Control or OptoMMP Protocol

If you are reading data from the module using PAC Control or the OptoMMP protocol, you will use
memory map addresses.

For either PAC Control or the OptoMMP protocol, you can use PAC Manager's Inspect window to
determine the memory map address. In our example above, for the SSI module installed in position
5, port 1, you can see that reading a float at address F0265040 would retrieve the Scaled Units value.

PAC Control does not have specific commands for these modules, and the SNAP-SCM-SSIis not a
module type you can select in the PAC Control debugger. Use the I/0 Unit—Memory Map
command “Read Number from 1/0 Unit Memory Map”in PAC Control.

Reading Data using Modbus/TCP

The data presented by the SNAP-SCM-SSI is available to a Modbus/TCP client. When accessing the
I/0 unit's Modbus/TCP server, use these equations to determine the holding register location:
First Holding Register = 1 + 2 * ((4 * [Module Number]) + [Port Number])
Second Holding Register = 2 + 2 * ((4 * [Module Number]) + [Port Number])
In our example, where the SNAP-SCM-SSIis installed in module position 5 and using port 1, here are
the completed equations:

First Holding Register = 1 + 2 * ((4 * 5) + 1) = 43

Second Holding Register = 2 + 2 * ((4 * 5) + 1) = 44

Note that holding registers are 4X, so in the Modbus/TCP client, you would read the holding register
pair 40043 and 40044 as a swapped 32-bit float number.
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2: Specifications and
Additional Information

Specifications

Maximum SSiI clock frequency 2.5 MHz

Channel-to-channel isolation 1500 VAC
Logic supply voltage 5.0 VDC
Logic supply current 200 mADC

SNAP PAC R-series controllers and SNAP PAC

Compatible I/O processors EB or SB brains with firmware 8.5c or newer

Number of ports per module 2

Max. number of modules per 8

rack

Max. data resolution 24 bits

500 feet at 200kHz using twisted-pair, 24-gauge
Maximum cable length shielded cable with an additional pair for com-
mon (three pairs total)

Operating temperature -20to 60 °C

Storage temperature -30to 85 °C

Torque, hold-down screws 4 in-Ib (0.45 N-m)

Torque, connector screws 5.26 in-Ib (0.6 N-m)

Agency approvals CE, RoHS, DFARS

Warranty 30 months from date of manufacture
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SPECIFICATIONS

Dimensional Diagram

* e—————— 325" (82.55mm)}————=]

T4 - -
(18.30mm) 20000| [00000)|
)
HOO00) 0o
3.59***
(91.18mm)
SIDE VIEW
(7737.26 | OF MODULE
.fZzmm
— —~—— A
(18.80mm)

TOLERANCES LEGEND
* +- 010" w4 +- 020"
kak - 030" wxex - 060"
NO * REFERENCE ONLY

SNAP SSI (Serial Synchronous Interface) Module User's Guide



Configuration Tables

CHAPTER 2: SPECIFICATIONS AND ADDITIONAL INFORMATION

Use these tables to note configuration values you calculate and obtain from the transducer
manufacturer’s data sheet (see “Calculating Configuration Parameters for PAC Manager” on page 4).

Data Frame Length

Clock Divider

Data Delay in Clock Cycles

Most Significant Data Bit Offset

Data Bits in the Data Frame

Error Bit Offset in the Data Frame' 2

Error Bit Level

Data Encoding

1. First error bit. Only one error bit can be monitored.
2. If your encoder has no error bit, use a value of -1.

Data Frame Length

Clock Divider

Data Delay in Clock Cycles

Most Significant Data Bit Offset

Data Bits in the Data Frame

Error Bit Offset in the Data Frame'* 2

Error Bit Level

Data Encoding

1. First error bit. Only one error bit can be monitored.
2. If your encoder has no error bit, use a value of -1.
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REMOVING A SNAP 1/0 MODULE

Removing a SNAP I/0 Module

To remove a SNAP 1/0 module, use the tool
that came with the module.

1. Turn off power to the rack.

WARNING: Make sure power is off before
continuing, or you will severely damage the
module.

2. Removethe module’s hold-down screws.

3. Holding the SNAP module tool as shown
in the illustration at right, insert it into the
notch at the base of the module.

NOTE: If you are facing the rack with the
processor on the left side, the notch is on the
back of the module, where the module
meets the rack.

N

4. Squeeze the module tool against the
module to open the release latch, and pull straight up on the module to remove it.
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